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ψ 4ÈÉÎÇÓ 9ÏÕ #ÁÎ $Ï %ÎÈÁÎÃÅ 9ÏÕÒ 0Ï×ÅÒÐÏÉÎÔ 0ÒÅÓÅÎÔÁÔÉÏÎÓ  

Your presentations always influence others to take some kind of action. The action might be to listen 
carefully and learn new information or it might be to drift off toward Dreamworld. The way in which 
your presentation delivers information has everything to do with how well it will be received. Here 
are some quick ideas for livening up your presentations to keep the after-lunch crowd awake in their 
seats. 

#1: Make your diagrams move 

You can go a step beyond your run-of-the-mill diagram by adding animation effects. Because the 
different shapes and text boxes in a diagram are all counted as separate objects in PowerPoint, you 
can assign animation and timing features to each of those elements so they slide in at just the right 
moment in your presentation. A little movement goes a long way, however, so be careful not to 
overdo it. You might do a simple slide-in-from-the-left for all the elements in a pyramid chart, for 
example. Too many will look ridiculous. 

#2: Make it easy for your audience 

A truly great presentation offers smart, memorable content in a design that helps reinforce the 
message and keeps people interested. You can write, edit, and organize the content in your 
presentation in a way that makes it easy for your audience members to follow your main points. 

To make sure your ideas are crystal clear, write the content of your presentation in Outline view 
ōŜŦƻǊŜ ȅƻǳ ŦƻŎǳǎ ƻƴ ǘƘŜ ŘŜǎƛƎƴ ŜƭŜƳŜƴǘǎ όǿƘƛŎƘ Ŏŀƴ ōŜ ŘƛǎǘǊŀŎǘƛƴƎ ōŜŎŀǳǎŜ ǘƘŜȅΩǊŜ ǎƻ ƳǳŎƘ ŦǳƴύΦ 
Make your main points your slide titles, include summary slides at key points (wherever ƛǘΩǎ 
ŀǇǇǊƻǇǊƛŀǘŜύΣ ŀƴŘ ŜƴŘ ǘƘŜ ǇǊŜǎŜƴǘŀǘƛƻƴ ǿƛǘƘ ŀ ǉǳƛŎƪ ǊŜǾƛŜǿ ƻŦ ǿƘŀǘΩǎ ōŜŜƴ ŘƛǎŎǳǎǎŜŘΦ 

 
 

#3: Get great new look 
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The templates provided with PowerPoint are predictabile. Consider creating your own custom 
template. 

 

#4: Let the Master do the work 

If you ŘƻƴΩǘ ǳǎŜ tƻǿŜǊtƻƛƴǘ ƻŦǘŜƴΣ ȅƻǳ Ƴŀȅ ƴƻǘ ōŜ ŎƻƳŦƻǊǘŀōƭŜ ǿƻǊƪƛƴƎ ǿƛǘƘ ǘƘŜ ǿƘƻƭŜ aŀǎǘŜǊ ƛŘŜŀΣ 
but Masters can save you a lot of time and help keep your presentation consistent. Suppose, for 
example, that there are three main sections in your presentation. By creating three Masters, one at 
the start of each section, you could add a colored bar as a tab along the right side of every side, with 
red for the first section, blue for the second, and green for the third. Tie the color scheme in with 
the slide title fƻǊ ŜŀŎƘ ǎŜŎǘƛƻƴ όŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ǎǳƳƳŀǊȅ ǎƭƛŘŜύΣ ŀƴŘ ȅƻǳΩǾŜ Ǝƻǘ ŀ ŎƻƭƻǊ-coded 
presentation that continually lets audience members know which section is being discussed and 
how many sections are left before the break. 

#5: Create custom bullets 

We can get bored to death with bullet points, but even the biggest bullet-detractors have to admit 
that they serve their purpose. Ideally, bullet points provide information in a succinct, easy-to-
understand format. PowerPoint makes it easy for you to substitute other characters for the regular 
round (or square) bullets that are part of the presentation template. But did you know you can add 
your own artwork easily to create customized bullets? 

Just display the Bullets And Numbering dialog box and click Picture. If you want to add your own art, 
click Import. Then, navigate to the image you want to use (our  logo? The UMES mascot?) select the 
file and define a custom bullet. 

 

#6:  Play show and tell 

Lƴ ǘƻŘŀȅΩǎ ¸ƻǳ¢ǳōŜ ŜǊŀΣ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ǘƻ Ǝƻ ŦŀǊ ǘƻ ōŜ ŜƴǘŜǊǘŀƛƴŜŘ ōȅ ŀ video clip on one of your 
favorite topics. Video clips are fun, fast-moving, and often funny. You can use video to your 
advantage in your PowerPoint presentation by including key segments at important points.   

Add video easily by clicking the Insert Media Clip button on a blank PowerPoint slide. PowerPoint 
will ask you to choose whether you want the clip to play automatically or when clicked. Make your 
choice and the clip is added to the slide. 

 

#7: A little music, please 

PowerPoint makes it reasonably simple for you to add sound effects and songs to your 
presentations. But one caveat: Sound effects can be really annoying if they are overused (especially 
the dinging sound of the cash register), so go easy on the bells and whistles (literally). You could add 
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a little sound to mark the start of the new section of your presentation, to give audience members a 
ōǊŜŀƪ ǿƘƛƭŜ ȅƻǳΩǊŜ ǇŀǎǎƛƴƎ ƻǳǘ ƳŀǘŜǊƛŀƭǎΣ ƻǊ ǘƻ Ǉƭŀȅ ƛƴ ǘƘŜ ōŀŎƪƎǊƻǳƴŘ ǿƘƛƭŜ ŀ ƳƻƴǘŀƎŜ ƻŦ ƛƳŀƎŜǎ 
displays on your slides. To add sound, choose Insert and select Sound. You can then specify whether 
you want to add sound from a file or from the Clip Organizer. You can also opt to play music from an 
audio track on a CD (remember to take the CD when you present!) or record a new sound. 

#8: Mix it up, visually 

Once you have a lock on your content, you need to think about the way all the design elements in 
your presentation will work together. To really add some visual interest, throw in some stunning, 
high-quality photos τ preferably of people or places. We all respond to images of happy, smiling 
people and beautiful landscapes.  

Use Visuals Instead of Text 
When possible, look for ways to use a visual, such as a diagram or photograph, to illustrate 
the point you are making instead of slide after slide of text.  Audiences respond better to 
visuals that get them thinking. 
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#ÏÎÖÅÒÔ 0Ï×ÅÒ0ÏÉÎÔ ςπρπ 0ÒÅÓÅÎÔÁÔÉÏÎ 4Ï $ÉÆÆÅÒÅÎÔ &ÉÌÅ 

4ÙÐÅÓ 

This is different than just saving a powerpoint as a different file type so you need to be clear what 
you are being asked to do in your question.  

To begin, launch the PowerPoint 2010 presentation which you want to convert. Head over to File 
menu, and click Save & Send. 

 

From the main window, under File Types, click Change File Type. In right sidebar, you will see list of 
file types; PowerPoint 2007 & 2010 format pptx, PowerPoint 97-2003 Presentation (ppt), 
OpenDocument Presentation Presentation (odp), Template (pptx), PowerPoint Show (ppsx) and 
PowerPoint Picture Presentation (pptx). Click desired file type from the list. Under Image File Types, 
there are two file types; PNG(Portable Network Graphics) and JPG format.  
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It will bring up Save as dialog, specify the location where you want to save presentation and click 

Save. 
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POWERPOINT  FILE TYPES 

Save As file type Extension Use to save 

PowerPoint 
Presentation 

.pptx A PowerPoint 2010 or 2007 presentation, which is an XML-enabled file 
format, by default.  

PowerPoint Macro-
Enabled Presentation 

.pptm A presentation that contains visual basic (vba) code.  

PowerPoint 97-2003 
Presentation  

.ppt A presentation that you can open in PowerPoint 97 to Office PowerPoint 
2003.  

PDF Document 
Format 

.pdf A PostScript-based electronic file format developed by Adobe Systems 
that preserves document formatting and enables file sharing. 

XPS Document 
Format 

.xps A new electronic paper format for exchanging documents in their final 
form.  

PowerPoint Design 
Templates 

.potx A PowerPoint 2010 or 2007 presentation template that you can use to 
format future presentations. 

PowerPoint Show .pps; .ppsx A presentation that always opens in Slide Show view rather than in 
Normal view.  

PowerPoint 97-2003 
Design Template 

.pot A template that you can open in PowerPoint 97 to Office PowerPoint 
2003. 

Office Theme .thmx A style sheet that includes definitions of a color theme, font theme, and 
effect theme. 

PowerPoint Macro-
Enabled Show 

.ppsm A slide show that includes pre-approved macros that you can run from 
within a slide show. 

PowerPoint Add-In .ppam An add-in that stores custom commands, Visual Basic for Applications 
(VBA) code, and specialized features such as an add-in.  

PowerPoint 97-2003 
Add-In 

.ppa An add-in that you can open in PowerPoint 97 to Office PowerPoint 
2003. 

Windows Media 
Video 

wmv A presentation that is saved as a video. PowerPoint 2010 presentations 
can be saved at High Quality (1024 x 768, 30 frames per second); 
Medium Quality (640 x 480, 24 frames per sec); and Low Quality (320 X 
240, 15 frames per second). The WMV file format plays on many media 
players, such as Windows Media Player. 

GIF (Graphics 
Interchange Format) 

.gif A slide as a graphic for use on Web pages. 

The GIF file format is limited to supporting 256 colors. Therefore, it is 
more effective for scanned images such as illustrations. GIF can also be 
good for line drawings, black and white images, and small text that is 
only several pixels high. GIF supports animation and transparent 
backgrounds. 
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JPEG (Joint 
Photographic Experts 
Group) FileFormat 

.jpg A slide as a graphic for use on Web pages. 

The JPEG file format supports 16 million colors and is best suited for 
photographs and complex graphics.  

PNG (Portable 
Network Graphics) 
Format 

.png A slide as a graphic for use on Web pages. 

 

TIFF (Tag Image File 
Format) 

.tif A slide as a graphic for use on Web pages. 

TIFF is the best file format for storing bit-mapped images on personal 
computers. TIFF graphics can be any resolution, and they can be black 
and white, gray-scaled, or color.  

Outline/RTF .rtf A presentation outline as a text-only document tha provides smaller file 
sizes and the ability to share macro-free files with others who may not 
have the same version of PowerPoint or the operating system that you 
have. Any text in the notes pane is not saved with this file format. 

PowerPoint Picture 
Presentation 

.pptx A PowerPoint 2010 or 2007 presentation where each slide has been 
converted into a picture. Saving a file as a PowerPoint Picture 
presentation will reduce the file size. However, some information will be 
lost. 

OpenDocument 
Presentation 

.odp You can save PowerPoint 2010 files so they can be opened in 
presentation applications that use the OpenDocument Presentation 
format, such as Google Docs and OpenOffice.org Impress. You can also 
open presentations in the .odp format in PowerPoint 2010. Some 
information might be lost when saving and opening .odp files. 
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#ÒÅÁÔÉÎÇ Á 0Ï×ÅÒ0ÏÉÎÔ 3ÈÏ× 

When you deliver a PowerPoint presentation, you don't want technical issues--such as starting your 

presentation on the correct slide--to concern you. Microsoft PowerPoint allows you to save your 

presentations to start automatically by changing the settings within the program's menu. A 

powerpoint show is a presentation that always opens in Slide Show view rather than in Normal view.  

Save Presentation as a PowerPoint 2010 Show File 

 

Save the presentation containing the PowerPoint triggers, transitions, animations, sounds, timings, 

ink marks, etcetera  as a PowerPoint show file. This will embed the sound/music files into the 

presentation so that they will be included when you email this show to others. 

1. Choose File > Save As 

2. In the Save As dialog box, type a name for the file (if it is not already named) and then click 

on the drop down arrow for Save as type: 

3. Scroll to select the option PowerPoint Show (*.ppsx). 

4. Click the Save button. 

 

How to Create a Custom Show in PowerPoint 2010 

To create a custom show in PowerPoint 2010: 

1. Before you start creating your custom slide show, create all the necessary slides. 

2. On the Slide Show tab, in the Start Slide Show group, click Custom Slide Show, and then click 

Custom Shows. 

 

2. In the Custom Shows dialog box, click New.  

http://0.tqn.com/d/presentationsoft/1/0/f/T/-/-/10-save-as-show.png
http://theapptimes.com/wp-content/uploads/2011/03/custom-slide-show.png
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3. In the Define Custom Show dialog box, in the Slides in presentation list box, select the slides that 

you want to include in the custom show, and then click Add. To select multiple slides in sequence, 

Shift-click  the desired slides. To select multiple slides in a non sequential order, Ctrl-click the desired 

slides. 

 

4. If necessary,  in the Slides in custom show list box, select a slide, and then click the Up or Down 

arrows to move the slide up or down in the list. 

 

5. In the Slide show name text box, enter a name for the custom show and click OK. 

6. Close the Custom Show dialog box. 

You can also create additional custom shows with any of the slides in your presentation. 

 

 

http://theapptimes.com/wp-content/uploads/2011/03/define-custom-show.png
http://theapptimes.com/wp-content/uploads/2011/03/change-the-order-of-slides.png


 

12 | P a g e 

 

(Ï× ÔÏ !ÄÄ !ÕÄÉÏ ÔÏ Á &ÕÌÌ 0ÒÅÓÅÎÔÁÔÉÏÎ ÉÎ 0Ï×ÅÒ0ÏÉÎÔ ςπρπ 

 

1. Click on a slide in the presentation at the point where you want to add audio (usually this 
will be the title slide) 

2. Click on the Insert tab of the ribbon 

3. Click the drop down arrow under the Audio icon on the right side of the ribbon. 

4. Select Audio from File... 

 

5.  

1. Navigate to the folder on your hard drive containing the audio file you want to use. 
Double-click on the audio file to add it to the presentation. Click on the arrow next 
to an audio clip you want to use, and then click "Insert" to bring it into your 
presentation. 

 

 

LŦ ǇǊƻƳǇǘŜŘ ǘƻ ŀƴǎǿŜǊ άIƻǿ Řƻ ȅƻǳ ǿŀƴǘ ǘƘŜ ǎƻǳƴŘ ǘƻ ǎǘŀǊǘ ƛƴ ǘƘŜ ǎƘƻǿέΣ ǎŜƭŜŎǘ ȅƻǳǊ ƻǇǘƛƻƴΦ ²Ŝ 
suggest you choose automatically 

http://0.tqn.com/d/presentationsoft/1/0/k/T/-/-/01add-sound-powerpoint.png
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Note - To have the best success with playing music or sound files in your presentations, always keep 
your sound files in the same folder in which you save your PowerPoint 2010 presentation. 

 

Click the "Play/Pause" button below the audio icon on the slide to preview how the audio sounds in 
your presentation. 

 

6. Click on the sound file icon on the slide to access Sound or Music Options in Your 
Presentation 

 

 

7. The ribbon should change to the contextual menu for sound.  

 

 

When the sound icon is selected on the slide, the contextual menu changes to reflect options 
available for sound. 
 
¶ Editing options  

¶ trim the audio track 
¶ fade sound in and/or out 

 Audio options  
¶ volume 
¶ start on click of the sound icon, play automatically and/or across a specific number 

of slides 
¶ hide the sound icon on the slide 
¶ whether to loop (play continuously) the sound until manually stopped  

http://presentationsoft.about.com/od/s/g/slide.htm
http://presentationsoft.about.com/od/r/g/ribbon.htm
http://presentationsoft.about.com/od/c/g/contextual_tabs.htm
http://presentationsoft.about.com/od/c/g/contextual_tabs.htm
http://0.tqn.com/d/presentationsoft/1/0/m/T/-/-/03playback-powerpoint-sound.png
http://0.tqn.com/d/presentationsoft/1/0/n/T/-/-/04edit-powerpoint-sound.png
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¶ rewind after playing 
 

 

These changes can be made at any time after the sound file has been inserted into the presentation. 
Our personal suggestions are that you have the audio: 

V Loop until stopped (this means that it will play continuously until the slide show 
itself stops).  When this is ticked, the song will start playing again from the 
beginning if it finishes before your presentation is over. 

V Have the music both fade in and fade out with a 5 second timing for both 

V Hide the sound icon during the show (it looks better this way) 

V Select "Play across all slides" under the "Start" list. This setting will cause the song to 
play throughout the presentation. 

V Be cognizant of the timing of the music and the slideshow. You can always trim the 
audio if it is too long. 
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!ÕÄÉÏ !ÎÄ 6ÉÄÅÏ &ÉÌÅÓ 3ÕÐÐÏÒÔÅÄ 

The following tables show the audio and video file formats that you can use in PowerPoint 2010. If 
you do not see a file format listed below, you can convert that file type to a supported file format by 
using programs, utilities, or add-ins other than PowerPoint 2010 such as those listed below. 

¶ Microsoft Windows Media Encoder     Windows Media Encoder is a free program that makes some 
files compatible with PowerPoint.. 

¶ Windows Media Player    Windows Media Player is a digital media player and media library 
application used for playing audio, video, and viewing images on personal computers running the 
Microsoft Windows operating system, as well as on Pocket PC and Windows Mobile-based devices. 

Compatible audio  file formats  

File format  Extension More information 

AIFF Audio file .aiff Audio Interchange File Format     This sound format originally was used on Apple and 
Silicon Graphics (SGI) computers. These waveform files are stored in an 8-bit monaural 
(mono or one channel) format, which is not compressed and can result in large files.  

AU Audio file .au UNIX Audio     This file format typically is used to create sound files for UNIX 
computers or the Web. 

MIDI file  .mid or .midi Musical Instrument Digital Interface     This is a standard format for the interchange of 
musical information between musical instruments, synthesizers, and computers.  

MP3 Audio file .mp3 MPEG Audio Layer 3     This is a sound file that has been compressed by using the 
MPEG Audio Layer 3  

Windows Audio 
file 

.wav Wave Form     This audio file format stores sounds as waveforms, which means that 
one minute of sound can occupy as little as 644 kilobytes or as much as 27 megabytes 
of storage.  

Windows Media 
Audio file 

.wma Windows Media Audio     A digital audio coding scheme developed by Microsoft that is 
used to distribute recorded music, usually over the Internet.  

Compatible video file formats  

File format Extension More information 

Adobe Flash 
Media 

.swf Flash Video     This file format is generally used to deliver video over the Internet using the Adobe 
Flash Player.  

Windows Media 
file 

.asf Advanced Streaming Format     This file format stores synchronized multimedia data and can be 
used to stream audio and video content, images, and script commands over a network.  

Windows Video 
file 

.avi Audio Video Interleave     This is a multimedia file format for storing sound and moving pictures in 
Microsoft Resource Interchange File Format (RIFF) format. It is one of the most common formats.  

Movie file .mpg or 
.mpeg 

Moving Picture Experts Group     This is an evolving set of standards for video and audio 
compression developed by the Moving Picture Experts Group. This file format was designed 
specifically for use with Video-CD and CD-i media.  

Windows Media 
Video file 

.wmv Windows Media Video     A tightly compressed format that requires a minimal amount of storage 
space on your computer's hard disk. 
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2ÅÃÏÒÄ !ÎÄ 4ÉÍÅ 6ÏÉÃÅ .ÁÒÒÁÔÉÏÎ 

 Note: To record/ playback narration, your computer must have a sound card, microphone, and speakers. 
 

Good presentations include concise slide content which is supported and reinforced by a presenter's 
gestures and discussion. When creating a video version of a presentation, you'll probably want to 
άŎŀǇǘǳǊŜέ ǘƘŜ ƘǳƳŀƴ ŜƭŜƳŜƴǘ ƻŦ ǘƘŜ ǇǊŜǎŜƴǘŀǘƛƻƴ ōȅ ǊŜŎƻǊŘƛng and timing voice narration and even 
laser pointer gestures.  

You can record your slide show prior to sharing it with your audience, or you can record a narration 

while actively delivering a presentation to a live audience and include their comments and questions 

in the recording.  

Record a narration before or during a slide show 

1. When you record a narration, you run through the presentation and record each slide. You 
can pause and resume recording any time. 

2. Ensure your microphone is set up and in working order prior to recording your slide show.  

3. On the Slide Show tab, in the Set Up group, click Record Slide Show . 

4. Select one of the following: 

¶ Start Recording from Beginning 
¶ Start Recording from Current Slide 

 
5. In the Record Slide Show dialog box, select the Narrations and laser pointer check box, and if 

appropriate, select or deselect the Slide and animation timings check box.  

6. Click Start Recording. 

Tip   To pause the narration, in the Recording shortcut menu, click Pause. To resume, click Resume Recording. 

7. To end your slide show recording, right click the slide, and then click End Show. 

8. The recorded slide show timings are automatically saved and the slide show appears in Slide 
Sorter view with timings beneath each slide.  

http://office.microsoft.com/en-us/powerpoint-help/record-and-add-narration-and-timings-to-a-slide-show-HA010338313.aspx?CTT=5&origin=HA010336763#_Record_a_narration
http://office.microsoft.com/en-us/powerpoint-help/record-and-add-narration-and-timings-to-a-slide-show-HA010338313.aspx?CTT=5&origin=HA010336763#_Record_a_narration
http://office.microsoft.com/en-us/powerpoint-help/record-and-add-narration-and-timings-to-a-slide-show-HA010338313.aspx?CTT=5&origin=HA010336763#_Record_a_narration
http://office.microsoft.com/en-us/powerpoint-help/record-and-add-narration-and-timings-to-a-slide-show-HA010338313.aspx?CTT=5&origin=HA010336763#_Record_a_narration
javascript:AppendPopup(this,'191834525_1')
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(Ï× ÔÏ #ÏÎÖÅÒÔ 0Ï×ÅÒ0ÏÉÎÔ 0ÒÅÓÅÎÔÁÔÉÏÎÓ ÔÏ 6ÉÄÅÏ 

How to convert PowerPoint PPT files to Video for uploading to YouTube. Or you can burn a DVD of 
PowerPoint presentations. 

1. You can upload PowerPoint videos to YouTube, Facebook, the Web, etc 

2. You can transfer PowerPoint slides to an iPod or a mobile phone and enjoy the presentations 
while on the move even without a PowerPoint viewer app. 

3. If your slideshow is like a photo album with lot of images, convert the PowerPoint to video and 
burn onto a DVD ς you can now watch the presentations on a large TV screen. 

The possibilities are endless. PowerPoint files converted to video using this technique also preserve 
all the voice narrations. And as expected, the total cost is $0. 

 

Why turn your presentation into a video?  
 

When you want to give a high-fidelity version of your presentation to colleagues or to other 
constituents such as students, alumni, or accrediting/reporting agencies (either as an e-mail 
attachment, published to the web, on a CD or DVD), save it and let it play as a video.  

In PowerPoint 2010, you can now save your presentation as a Windows Media Video (.wmv) file, 
and distribute it confidently, knowing that your animated, narrated, multimedia presentation will 
play without a glitch. If you do not want to use the .wmv file format, you can use a preferred third 
party utility to convert your file to another format (.avi, .mov, etc). 

Some tips to remember when recording your presentation as a video:  

¶ You can record and time voice narration and laser pointer movements in your video. 

¶ You can control the size of the multimedia file and the quality of your video. 

¶ You can include animations and transitions in your movie. 

¶ Viewers do not need to have PowerPoint installed on their computers to watch it. 

¶ If your presentation contains an embedded video, the video will play correctly without your 
needing to control it. 

 

http://office.microsoft.com/en-us/powerpoint-help/redir/HA010336726.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA010336722.aspx?CTT=5&origin=HA010336763


 

18 | P a g e 

 

3ÁÖÅ 9ÏÕÒ 0ÒÅÓÅÎÔÁÔÉÏÎ !Ó ! 6ÉÄÅÏ 

 

1. Create your presentation. 

¶ (Optional) Record and add narration and timings to a slide show and Turn your 
mouse into a laser pointer. 

2. On the File menu, click Save & Send. 

3. Under Save & Send, click Create a video.  

 

4. To display all video quality and size options, under Create a video, click the Computer & HD 
Displays down arrow. 

5. Do one of the following: 

¶ To create a video with very high quality, yet a large file size, click Computer & HD 
Displays. 

¶ To create a video with a moderate file size and medium quality, click Internet & 
DVD.  

¶ To create a video with the smallest file size, yet low quality, click Portable Devices. 

8. Click the Don't Use Recorded Timings and Narrations down arrow and then, do one of the 
following: 

¶ If you did not record and time voice narration and laser pointer movements , click 
Don't Use Recorded Timings and Narration. 

 Tip   The default time spent on each slide is set to 5 seconds. To change that, to the right of Seconds to spend on each 
slide, click the up arrow to increase, or the down arrow to decrease the seconds. 

http://office.microsoft.com/en-us/powerpoint-help/redir/HA010338313.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA101794344.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA101794344.aspx?CTT=5&origin=HA010336763
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¶ If you recorded and timed narration and pointer movements , click Use Recorded Timings 
and Narrations.  

9. Click Create Video. 

10. In the File name box, enter a file name for the video, browse for folder that will contain this 
file, and then click Save. You can track the progress of the video creation by looking at the 
status bar at the bottom of your screen. The video creation process can take up to several 
hours depending on the length of the video and the complexity of the presentation. 

 Tip   For longer videos, you can set it up so that tƘŜȅ ŎǊŜŀǘŜ ƻǾŜǊƴƛƎƘǘΦ ¢Ƙŀǘ ǿŀȅΣ ǘƘŜȅΩƭƭ ōŜ ǊŜŀŘȅ ŦƻǊ ȅƻǳ ǘƘŜ 
following morning.  

11. To play your newly-created video, go to the designated folder location, and then double-
click the file. 

 

What parts of a presentation will not be included in a video? 

The following items will not be included in a video that you create using PowerPoint:  

¶ Media inserted in previous versions of PowerPoint. To include these, you can convert or 
upgrade the media object. 
 

 What to do with your video after creating it? 

After you create a video, you can share it with others by using the following methods:  

¶ Use e-mail to send a presentation or a link to a presentation 

¶ Burn your slide show to a DVD disc 

¶ Upload it to a video sharing Web site, such as YouTube 

¶ Save to a file share or other location 

 

(Ï× ÔÏ 5ÐÌÏÁÄ 6ÉÄÅÏÓ -ÁÄÅ ÉÎ 0Ï×ÅÒ0ÏÉÎÔ ÔÏ 9ÏÕ4ÕÂÅ 

Once you have created a PowerPoint file and added transition timings you can save your file (using 
the previous directions to a video format). File Tab, Save and Send, Create a Video (select size 
option, and whether to select your pre designated transitions and timing or pick from or check a 
quick default, then click save). It takes a view minutes but you have now created a .wmv file. If you 
are worried about sound it is not a problem as you can either use one of any number of free songs 
available in Youtube. 

(Note:If you really want to be super fast just take the PowerPoint without worrying about adding 
transitions of anything and then go right to save and send and select the default timing. Then use 
one of the free songs in YouTube.) 

http://office.microsoft.com/en-us/powerpoint-help/redir/HA010336720.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA010382168.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA101730019.aspx?CTT=5&origin=HA010336763
http://office.microsoft.com/en-us/powerpoint-help/redir/HA010336440.aspx?CTT=5&origin=HA010336763


 

20 | P a g e 

 

 

To get started uploading videos on YouTube, follow the steps below: 

1. Visit www.youtube.com 

 

2. Sign into YouTube. 
1. If you do not have an account create a free one now  
2. Click Sign In Then Create an Account 

3. Click the Upload link at the top of the page. 

 

4. Click Select Files to Upload 
5. Enter the details 

 

http://www.youtube.com/
http://www.wikihow.com/images/7/7c/Upload-a-Video-to-YouTube-Step-4.jpg
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6. Hit Save. Your title, description, etc. will be saved when your video has completed uploading. 

When the bar fills, you have posted a video on YouTube. 

1. Once the upload is complete you can edit your video during which time you can add 

one of the free songs available for use on Youtube. 

 

!ÄÄÉÎÇ 9ÏÕ4ÕÂÅ 6ÉÄÅÏÓ ÔÏ "ÌÁÃËÂÏÁÒÄ 

You can embed YouTube videos into your course website in Blackboard. You will never have to worry 

about links not working and they will play on successfully regardless of the device being used by the 

student. Also no download is required on the part of the viewer. 

1. Log into your course in Blackboard 

2. Navigate to the page were you would like to add a video 

3. Select Build Content and expand the drop down. 

 
4. From the drop down choices select YouTube 

5. Search for the video you would like to add. It will be recognized by the Tags you 

previously entered when you uploaded the video to YouTube. 

1. (Hint: I always include my own last name in my tags so that my videos 

are easy for me to find later). 
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6. You will be able to preview the videos. Just click Preview. 

7. Once you know the video you want to add click Select 

1. You will be able to add a description. 

 


